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CamRanger Hardware

The CamRanger device is turned on by sliding the Wireless

power switch, located on the side of the unit, P°W9L_‘\‘I I_USB
towards the front of the device. The green power /// Ll
light will illuminate when the unit is powered on. rd < )
Any additional switch present on the CamRanger %)szg'

currently serves no function. \N e
\ @ ’

N CI‘_
Power Switch

The charging port is located next to the power J
switch. The _maIe mlc?ro B end of the pr_owded USB Port Charging Connector
white charging cord is connected to this port. (connects to camera)

The other end of the charging cord can be
connected to a female USB port that provides power, such as a computer or through the
provided AC adapter.

When the device is charging, an additional yellow light will illuminate next to the green power
light indicating that it is charging. The yellow light will turn off leaving only the green power
light when it is fully charged.

The CamRanger battery is accessible by removing the bottom cover. The bottom cover is the

Ho43a0gy 1y 4,
Jaﬁuey,,,,’_;' &

side with the CamRanger serial number. Simply grasp the side edge/corner of the cover near
the USB connector and pull back to remove. To replace the cover, first place the two lower tabs
into the slots and then snap in the top.

2

CamRanger is not water-resistant in any way and should not get wet.
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A black neoprene case is provided to assist in attaching and securing the CamRanger, note that
this pouch is not waterproof. The case has a carabineer to facilitate hanging from a tripod, belt
loop, etc. Do not just hang the CamRanger by the cable as it will put strain on the USB
connectors as well as possibly disconnect.

Any switch on the opposite side of the power switch does not currently have any functionality.

CamRanger Registration

Before a Mac can be used with a CamRanger, the application should be loaded on the Mac, at
no additional cost to the user, from the CamRanger website,
http://www.CamRanger.com/Downloads. Once downloaded, the CamRanger application
needs to be registered. Registration requires Internet connectivity. Before proceeding, confirm
Internet connectivity (do not connect to the CamRanger network).

Launch the CamRanger application and the following screen appears. If the registration pop-up
does not appear, from the “Help” tab on the Mac menu bar, click “Register,” and the following
screen will appear.

CamRanger Registration
Please enter your serial code located on the back of your CamRanger:

CamRanger
Serial #: ABCDEFGH

Note: you must be connected to the Internet

Register

Enter the 8-character CamRanger serial number. The serial number is located both on the
bottom of the back cover as well as above the battery underneath the back cover. Note that the
serial number contains only letters and NO numbers.

Press the “Register” button to complete the registration process. A message box will appear
indicating registration was successful and the Mac can be used with the CamRanger. Exit the
application and then proceed with the setup process as detailed below in the CamRanger Setup
section.

If registration fails, confirm Internet connectivity and the CamRanger serial number before
contacting support@CamRanger.com for assistance.
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CamRanger Setup

Power on the CamRanger and confirm all four lights briefly appear. The CamRanger will take
approximately 30 seconds until it is fully initialized.

The first time the user connects to CamRanger from a Mac, the Mac needs to be registered. See
the CamRanger Registration section above.

Once registered, connect to the CamRanger network on the Mac. The network name will be
CamRanger-###, with the last three characters matching the last 3 characters of the
CamRanger’s serial number. Enter the network password, which is the full 8 characters of the
CamRanger’s serial number. The password MUST BE ENTERED IN ALL CAPS.

Connect the CamRanger to the camera with the provided black USB cable (Note: units
purchased through retailers will have a USB mini cable, which will work with most cameras. A
few select Nikons use a different cable, which may be purchased separately or the cable that
came with the camera will also work). The male A end is inserted into the USB port at the end
of the CamRanger, and the other end is connected to the USB port of the camera. Then ensure
the camera is turned on. When the camera is connected and turned on, the green light closest
to the edge of the CamRanger device will light.

Launch the CamRanger Mac application. The application will connect to the CamRanger and the
user will be able to control the camera. To attempt to manually initiate a connection, on the
Mac menu bar, click “Connection” and then “Connect.” Once connected, the following screen
will appear.

Connected to camera

For common problems with setup and connection refer to the Troubleshooting section of this
manual found on page 24.
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CamRanger Mac Application

Status Bar Recent Thumbnails

enon CamRanger x”
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1S0 400
Camera
Properties
ik v
Actions

Image Size

Status Bar

a Canon EOS 7D | EFSOmm f/1.4 USM Shots: 51

The status bar is located at the top of the application screen and provides the user with a
number of status elements.
From left to right:
* Camera Connection: Indicates if the CamRanger device is currently communicating with
the camera
o Connected: (!
o Disconnected: X
* Camera Battery Status: Indicates the approximate battery charge on the camera
* Camera Model Name
* Lens Model Name (Note: not all cameras or lenses are supported)
* Shots Remaining: Indicates the number of shots currently remaining on the camera’s
removable media using the current settings
* Maximizing, and minimizing a window
o Yellow and Green circle on upper left corner:
= Yellow: Used to minimize the window
= Green: Used to maximize the window
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o Click on the extending arrows, located on the upper right corner of the screen,
to view the window in full screen.

Recent Thumbnails

"‘l. A
. Ly 1o
b_9153.9G IMG_S155.076 IMG_5156.076 MG _F157.0P6 MG _5158.0P6

i

* Asimages are captured, the thumbnails are automatically downloaded and displayed
along the top of the screen. The thumbnails may be scrolled left and right when more
are downloaded than can fit.

* Athumbnail may be selected to view the corresponding image. The image is
downloaded and displayed in the main image view. The currently selected thumbnail is
indicated with a yellow outline.

* When both a JPG and RAW file format is captured, only the JPG thumbnail is displayed.

* For Canon, JPG and RAW files can be viewed. For Nikon, JGP can be viewed while the
RAW thumbnail will display, but will not be shown at full resolution when selected.
Instead all Nikon RAW files will be displayed in a compressed JPG version. However, if
the image is saved, it will save the full NEF file. Viewing TIFF files is not supported.

* Asmallred “R” icon on the upper right of the thumbnail indicates that it is a RAW
image. A small green “T” indicates TIFF, while no icon is used to indicate JPG formatted
images.

* Note: only thumbnails for images captured within the current CamRanger session will be
displayed.

Main Image View

Live view and captured images are displayed within the main image view.

Live View Images

To initiate live view, click on the eyeball symbol located within the camera action controls on
the bottom right of the application screen. In live view, the image on the screen is
automatically updated as live view images stream in. The exact frame per second rate is very
much dependent on the CamRanger WiFi signal strength, the camera, and the Mac specs.
However, assuming a good connection, the live view frame rate will be about 7 — 18 fps.

When in live view, the main image view may be clicked once to focus at that point. Note that
for Canon cameras, the outer edges of the image cannot be focused on. Double clicking will
zoom in the viewing window and double clicking again returns the image to regular size. A live
view histogram may be toggled on or off from the “Data” tab as described in the Advanced Tab
Data section found on page 9. Toggling the histogram on will generate a histogram for each live
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view frame; however, at the cost of a decreased frame rate. Toggle the histogram off to
maximize the frame rate. Canon cameras can display the live view image on the camera and
Mac and allow the user to trigger images with the camera by activating the camera’s live view
button after starting live view within the CamRanger application. Nikon cameras do not allow
any control of the physical camera while live view is active within the CamRanger application.

Captured Images

Captured images will be displayed in the main image view in one of two ways, by selecting a
thumbnail in the thumbnails section of the application or through the Auto-View Images
feature. The Auto-View Image feature is useful when capturing images from the camera and
using the Mac application for image display. When this feature is selected, pictures will
automatically display in the main image view screen. This feature can be turned on or off by
selecting “CamRanger” on the Mac CamRanger menu bar and then “CamRanger Preferences.”
For more information about this feature, refer to the CamRanger Menu Bar Preferences section
of this document found on page 15.

When a thumbnail is selected for viewing, the image will be displayed on the main image view
and can be zoomed in at 50%, 100%, 200%, or fit to screen by selecting the magnification of
interest below the image. The image can then be panned using the mouse.  Images displayed
in the main view are NOT saved by default, but are instead just temporarily cached. Individual
images can be saved by selecting “File” from the Mac CamRanger menu bar and then “Save” or
“Save As”. For further saving options including the ability to automatically save all pictures,
refer to the CamRanger Menu Bar Preferences section of this document found on page 15.

To view the images on the camera’s memory card select “View” on the Mac CamRanger menu
bar and then “Card Contents.” A new window will appear displaying thumbnails of the images
on the camera’s removable media. Double clicking a thumbnail will display the image within the
main image view. Additional features for downloading or deleting images are also available. For
further information about the card contents, refer to the CamRanger Menu Bar Card Content
section found on page 17.
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Advanced Tabs

There are four tabs providing advanced information or controls: Data, Focus, Timer, and HDR.
An additional Tripod or StackShot tab is visible when the respective accessory is connected.

Data

The data tab shows an RGB histogram and meta-data associated with the image in the main
image view. The following meta-data is provided:

* Shutter Speed el Focus | Timer | HDR
* Aperture
* MegaPixels (Note this is not file size, but image
resolution)
* ISO

* Metering Mode
* Exposure Compensation Value

Within live view, the data tab will simply inform the user that
live view is on and provide a toggle switch to toggle the display IMG_9153.JPG 1/6 2.8
of the histogram. The histogram is updated in real-time, but at 1S0400  8.0MP

the cost of slowing down the frame rate.

Focus
The focus tab is only enabled during live view and provides | Data BULEM Timer | HOR J
advanced focusing controls. Focus Adjust
Focus Nearer Focus Further
Focus Adjust u n n ’ u B
There are two sets of buttons to move the lens’ focal
plane nearer or further from the camera. Each set has Focus Stacking
three buttons with different sized arrows to specify a Step Size Number of Shots
large, medium, or small step in focus. Tap the button to [Medium | ] 3 |~]
move the focus by a single increment, holding down the

button will have no affect.

DOF Preview

Focus Stacking
Focus stacking is a process of taking multiple captures with slight changes in focus and
then post processing them to enhance the depth of field. The automatic focus-stacking
feature allows the user to set the focus step size between in each shot and the number
of shots to take. Each focus step will move the focal plane further from the camera. So
the user will want to set the focus to the nearest plane desired to be in focus and start
the stacking process from there. If too few captures are taken, the process can be
restarted from where the initial stacking ended. Note: the post processing is not done
within the CamRanger application.

© CamRanger - Patent Pending 9



Timer

The timer tab allows the use of the CamRanger as an intervalometer as well as specifying

exposure times when the camera is in bulb mode. tirmer) IEEE
Time Lapse Time Lapse
* The entry fields are used to specify the initial delay inical Delay [iRY : &9
before the first shot, the number of shots to take, Num Shots )
and the delay in between each shot. shot Delay [0 :
¢ After configuring the settings, press the “Start” @ HDR - 3 Shots - Step Size 1/3
button to begin the intervalometer process. Bulb

* The intervalometer commands are stored on the
CamRanger device, the Mac does not need to remain
on or connected once the intervalometer command
is initiated.

* The “Shot Delay” should not be used for precision timing, particularly when the
delay is only a few seconds or less.

* |f the user closes the CamRanger app after initiating the time lapse on the
CamRanger, which includes shot delays of 2 seconds or less, it may be difficult to
restart the app since the CamRanger is primarily communicating with the camera.

¢ Time Lapse —HDR

o If the camera is in manual exposure mode, a small HDR check box will appear
allowing the combination of a time lapse and HDR sequence.

o If the HDR check box is selected, for each time lapse capture, CamRanger will
actually take a sequence of bracketed images using the bracket parameters
as specified within the HDR tab.

* Time Lapse —Bulb

o Ifthe camera is in bulb mode/shutter speed and the camera supports bulb
shots, the CamRanger has the ability to take Bulb shots during the time lapse.
The bulb duration is specified by the Shot Duration, located within the Bulb
section, immediately below the time lapse section.

* Before starting the time lapse sequence, a dialog will appear informing the user of
the time lapse parameters and provide an opportunity to cancel.

Bulb capture is only available

while the camera is in bulb mode.

Bulb

* The Bulb controls are only enabled when the camera is in bulb mode and the camera
supports remote bulb shots.

* The entry fields are used to specify the initial delay before the first shot and the
length of the exposure.

* After configuration, press the “Start” button to begin the bulb process.

* The bulb commands are stored on the CamRanger device and the Mac does not
need to remain on or connected.

© CamRanger - Patent Pending 10



HDR

The “HDR”, or Advanced Bracketing, tab can be used to generate a series of photos with varying
exposures.

Data Focus @ Timer

* Advanced Bracketing is only enabled when the camera is

in Manual mer. - property  EETYIED
* The Property field specifies the camera property to be

varied. There are three options, Shutter Speed, LRl ST ITE

Aperture, and ISO. 00 Bl 00 | [1/30  [~]
* The Initial Delay field specifies the amount of delay, if _ _

to take before beginning the bracketing sequence e ot S .
any, .
Y B p

* The initial value for the selected property is set with the
Start Value field.

* The total number of images to capture is specified by the
Number of Shots field.

* The possible Step Size values are up to 3 stops and specify the how many stops to vary
the exposure between each capture.

* The valid values for the Number of Shots are automatically determined based on the
values specified for Start Value and Step Size. For example a step size of 1/3 stops will
allow more shots than a step size of 3 stops.

* The starting point of the bracket is set within the settings and can begin at the shadows
(lowest exposure), mid-point, or highlights (highest exposure). If the starting point is set
to mid-point, the resulting sequence will start at the lowest exposure but with the
initially set value as the mid-point. See the Advanced Settings section for more
information on setting the HDR start point.

¢ After configuration, press the “Start” button to begin the bracketing process.

* HDR sequences may be done with Live View active for Canon, but not Nikon.

* Note: the post processing is not done within the CamRanger application.

Tripod Tab

Data Focus Timer

When the CamRanger PT Hub and MP-360 (MP 101, Bescor, or
Hague) are in use with the CamRanger, an additional tab will
display for tripod control. The CamRanger Mac application
provides the user the option to pan and tilt the camera from
within the app at variable speeds. For more information refer to
the CamRanger PT Hub and Tripod section of this manual found

on page 21.
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StackShot Tab

When the CamRanger PT Hub and StackShot are uses with the CamRanger, an additional tap
will display for controlling the StackShot. Refer to the separate CamRanger & StackShot Manual
on our website, www.CamRanger.com/help, for more information about using the CamRanger,
CamRanger PT Hub, and StackShot. To use the StackShot with the CamRanger and CamRanger
PT Hub, the CamRanger firmware must be version 7 and up and the CamRanger software on
the Mac must be the most recent. These updates can be found on our website at
www.CamRanger.com/downloads.

Camera Properties
Auto Exposure Mode

1SO 400 150
1/500 Capture
= Mode
[:@] %

White

Mode 4 Balance
Image _L 4| + Focus
Format

Mode

Exposure Compensation
& Bracketing
The above diagram indicates the camera properties, which are also listed below, that can be set
using the application:

* Auto Exposure Mode * Shutter Seed

* Aperture * ISO

* Metering Mode * Capture Mode

* White Balance * Image Format

* Focus Mode * Exposure Compensation and Bracketing

Not all properties can be set for all cameras or in all modes. For example, the diagram above is
from a session with a Canon camera and for most Canons the auto exposure mode and focus
mode cannot be set. Disabled properties are indicated with a darker button background.
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Exposure Compensation & Bracketing

By clicking the bracketing button, the following controls will be displayed:

Clicking the arrows at the top right and left moves the exposure compensation. Holding down
the arrow will move the exposure compensation to its respective limit. The two buttons at the
middle control the bracketing amount. Clicking the arrows pointing in will reduce the

bracketing amount, while pressing the arrows point outward will increase the bracketing
amount.

The bracketing is not set until the “Set” button is
pressed. The “Close” button will dismiss the dialog.
Pressing “Close” without pressing “Set” will effectively

cancel any adjustments made.Camera Actions
Movie Mode

. . * M Auto / Manual
Live View :: m AF Focus Toggle

Trigger
Image Capture

Capture

o The “Capture” button initiates the camera trigger. The exact camera behavior is
dependent on the camera and camera properties, most importantly the capture
mode.

o For most capture modes, such as single, timer, or quiet the button performs the
image capture as expected. It should be noted that for some cameras, advanced
modes such as remote or timer the button will behave as single capture mode.

o Continuous capture mode differs between Nikon and Canon.

= Nikon: After selecting a continuous drive mode a dialog is displayed
allowing the user to select the number of images to capture. When the
Capture button is pressed, that number of images will be captured.

© CamRanger - Patent Pending 13



= Canon: When in a continuous mode, pressing and holding the Capture
button behaves in the same way as pushing the physical trigger on the
camera.
It is noted that there can be a very slight lag between the pressing of the
“Capture” button and the image capture. The delay can be more pronounced
while live view is active. For time critical applications, a remote trigger, such as
an RF trigger, can be used in combination with the CamRanger.

Auto / Manual Focus Toggle

o The AF/MF Focus toggle button allows the user to change the focusing between
auto and manual without having to physically adjust the camera.

o This AF/MF adjustment is not possible for all cameras in all modes. For example,
some Nikon cameras are required to be connected in “PC” mode, which is
accessible by selecting “Connection” on the Mac CamRanger menu bar followed
by clicking “PC.”

o After any touch or incremental focusing while in live view, the focus mode will
automatically attempt to switch to manual focus such that the user specified
focus is not overridden by auto focus upon capture.

Live View

o The “Live View” toggle button is used to turn live view on and off.

o When live view is on, the main image view is updated with live view images as
well as updating the RGB histogram in the Data tab if the live view histogram is
turned on.

o Note: running live view is relatively intensive and there may be slight
performance lags in other areas.

Movie Mode
o The “Movie Mode” toggle button is used to turn live view on and off, but within

movie mode.

When movie mode is on, the main image view is updated with the live images.
The “Capture” button changes to “Record” and pressing the “Record” button will
start and then stop the recording of a movie.

Note: movies cannot be downloaded to the Mac using the CamRanger.

© CamRanger - Patent Pending 14



Mac CamRanger Menu Bar
® CamRanger File Connection View Window Help

The CamRanger menu bar located at the top of the Mac display contains many useful functions
allowing the user to manage the connection, set options and controls, access to the camera’s
card contents, and to get help.

CamRanger Preferences
The preferences are accessible from the menu bar, by clicking “CamRanger” and then selecting
“CamRanger Preferences” on the dropdown.

® 00 CamRanger Preferences

Saving
* Saved Image Directory: As images are
captured they can be saved into a specified

Saving

Saved Images Directory

. . , /Users/admin/Pictures Browse ‘
directory. If pictures from the camera’s .
|| Custom Prefix
memory card are downloaded to the Mac
they will be stored in this folder. It is noted ,
Rk , |_| Auto-View Images || Auto-Save Images
all images are always stored on the camera’s
memory card. R
* Custom Prefix: This will give the images taken l? B 3 v
during the session a unique title preceding LD RS R
the image number when saved to the Controls
computer. HDR Start Point
* Auto View Images: This feature will Mid-Point ||
automatically display images as they taken. Sharing
Pictures will display regardless of whether  Enable Sharing Show Clients_ ]
they are captured from the Mac or the
|_| Auto Share Images | | Auto Share Thumnails (¥ Share Live View
camera.
* Auto Save Images: When this feature is Watermark
selected, the images will automatically be  Show Watermark
saved to the directory during the CamRanger R
Watermark || Size |Large | v

session regardless if the images are captured
from the Mac or the camera. This is typically
used to use the CamRanger to “shoot into Lightroom” or other similar programs.

Viewing
* Name: Displays the images file name at the bottom left of each image
* Grid Lines: Overlay a 3x3 grid over the main image view
* Aspect Ratio: Overlays red lines over the main image view to give the user visual
feedback on common cropping ratios. Note: this information is not saved with the
image.
* Nikon RAW (NEF) Quick View: The NEF files will be viewed as a compressed JPG image
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Controls
HDR Start Value: Specifies where the selected HDR property value is within the bracket,

at the most exposed point (Highlights), least exposed point (Shadows) or in the middle
(Mid-Point).

Sharing

Refer to the CamRanger Share section of this manual on page 20 for more information
about the sharing features.

Watermark

* Watermark: Insert text here to use for the watermark.

* Show Watermark: Displays a watermark over each full size image. When the watermark
is enabled and the user is sharing images to multiple devises, the watermark will be
displayed on the shared devices.

* Watermark Location: Specifies the location of the watermark: Center, Bottom-Right or
Bottom-Left.

File: Saving & Sharing Options
* The “Save” and “Save as” options are beneficial for users who do not want all images
captured to be saved onto the Mac.

o Save: The image displayed on the main viewing screen can be saved to the
default directory by selecting “File” on the Mac CamRanger menu bar followed
by “Save.”

o Save as: The image displayed on the main viewing screen can be saved to any
directory and any name by selecting “File” on the Mac CamRanger menu bar
followed by “Save.”

o Images can also be auto-saved to the Mac computer via the CamRanger
Preferences.

* Share: When sharing is enabled, the CamRanger user can chose to share individual
images being viewed in the main image view by selecting “Share” from the File drop
down.

Connection

* CamRanger Connection: A state dependent “Connect” or “Disconnect” button is
available to the user as a troubleshooting option to avoid closing the application in the
case of connection problems.

* Nikon Connection Mode

o After selecting “Connection” on the menu bar, the options of “PC” and “Camera”
are in the dropdown.
= PC: PC mode allows more control over properties within CamRanger;
however, any properties changed are not maintained, and changing
settings on the physical camera are not recognized. Additionally, images
cannot be physically triggered from the camera.
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= Camera: Allows the camera to be physically used as normal; however, not
all properties will be enabled within CamRanger. The CamRanger
application must be set to Camera mode to allow physically triggering
from the camera.
* It should also be noted that the connection mode cannot be changed while live view is
active.

View

Card Contents

6 O O Camera Card Contents

R

2G6A9200.CR2 2G6A9198.CR2 2G6A9197.CR2 2G6A9196.CR2
2G6A9199.CR2

—
Wy

°wa
2G6A9195.CR2 2G6A9194.CR2 2G6A9192.CR2 2G6A9191.CR2
2G6A9193.CR2

R R R <R m
= | -
- . o -

2G6A9190.CR2 2G6A9189.CR2 2G6A9188.CR2 2G6A9187.CR2 IMG_9186.CR2

To view the card contents select “View” on the Mac CamRanger menu bar and then “Card
Contents.” By doing this a new window will pop-up, as seen above. The card contents will
display thumbnails of the images on the camera’s removable media. The application will initially
load the most recent thumbnails. To load more thumbnails, press the “More” button at the
bottom of the window. As seen in the picture above, a small red “R” icon on the upper right of
the thumbnail indicates that it is a RAW image. A small green “T” indicates TIFF, while no icon is
used to indicate JPG formatted images.

Any number of thumbnails can be selected by pressing a thumbnail, or all may be selected by
pressing “Select All” at the bottom of the window. Selected thumbnails will have a yellow
border around them. After selecting thumbnails they may either be deleted or saved. The
“Delete” button at the lower left will first prompt the user to confirm, and then delete the
associated images of the selected thumbnails from the camera’s removable media. The “Save”
button at the lower right will save all associated images of the selected thumbnails to the image
directory specified in the preferences. Images are saved regardless of format. Images within
the card contents view can be viewed by double clicking on the image. The image will then
appear in the main image view window.
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Note that the thumbnails are presented in chronological order beginning with the most recent.
However, for Nikon they are grouped first by format, such that all JPG’s will be listed, then
TIFF’s, and finally RAW images.

Controls

When the “Control” function is turned on, the camera settings and image capturing can be
controlled on the Mac since the advanced controls tab, camera properties, and camera actions
are accessible on the right hand side of the application. Thumbnails of the images captured
within the CamRanger session will appear on the upper portion of the screen, the main image
view will show live view or captured images.

When the control function is turned off, the advanced controls tab, camera properties, and
camera actions will not appear on the application screen, while the thumbnails of images taken
within the CamRanger session will appear on the upper portion of the screen and the main
image view will display the captured images. The camera settings and image capturing can be
controlled from the camera and are not controlled on the Mac application.

Image Only

When “Image Only” is selected, the advanced controls tab, camera properties, and camera
actions on the right hand side of the application are not visible. The thumbnails of images
taken within the CamRanger session will not appear on the upper portion of the screen. When
“Image Only” is not selected, the advanced controls tab, camera properties, camera actions,
and thumbnails are accessible on the CamRanger application.

Window

The “Window” dropdown found on the Mac CamRanger menu bar allows the user to minimize
and zoom the screen, bring the CamRanger windows to front, and access the camera card
contents.

Help
The “Help” dropdown found on the Mac CamRanger menu bar is useful for registering
CamRanger units and to access this help manual.
* Registration: By clicking “Register” the user can register a CamRanger. The user must be
connected to the Internet to complete the registration.
* CamRanger Help: Click “CamRanger Help” to view this document.

Incorporation with Lightroom or Aperture

While one cannot control the CamRanger from within Lightroom or Aperture, one can specify a
folder to automatically download images to. Refer to the CamRanger Menu Bar Preferences
section found on page 15 for more saving options. This folder can be set to as a “watch” folder
within Lightroom or Aperture and set to be automatically imported.
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Network Bridging

To set up network bridging the CamRanger must have firmware 6 and up and the CamRanger
Settings application must be downloaded on the Mac computer. Refer to
www.CamRanger.com/downloads for the CamRanger firmware update and for the CamRanger
Settings application and user manual to establish bridging on the Mac. For further guidance, a
YouTube CamRanger Settings application user video is available. Note that to bridge networks it
is recommended to be familiar with Internet networking.

Network bridging allows the user to be connected to the CamRanger and an additional Internet
network simultaneously. Previously when using the CamRanger, the Mac could only be
connected to the CamRanger WiFi network, making it so the user could not use any other
network when the CamRanger was in use. Once the bringing is established on the Mac, the

CamRanger can be connected to the Mac and successfully bridge between the CamRanger and
additional network.
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CamRanger Sharing

In order for the CamRanger Share feature to work, the CamRanger firmware must be
updated to version 6 and up and the CamRanger software must be updated to the
most recent version. When the photographer is in a CamRanger session, others can
view images and live view on their personal iOS devices, Android devices, and/or Mac
or Windows computer. The CamRanger Share application is free and can be
downloaded from www.CamRanger.com/downloads. Individuals using the CamRanger Share
app can only view images and live view when the CamRanger is connected and the main
CamRanger user has enables sharing from within the settings.

The Mac Share settings, as seen below, can be accessed by selecting “CamRanger” from the
Mac menu bar followed by “Preferences.”

Sharing
M Enable Sharing | Show Clients |
[ Auto Share Images || Auto Share Thumnails [V share Live View

* Enable Sharing: When viewing an image in the main image view, individual images can
be shared by enabling sharing in the CamRanger Settings and then selecting “Share”
from the File drop down. One must Enable Sharing in order for the Auto Sharing, Auto
Share Thumbnails, and Share Live View settings to work.

* Auto Share Images: Any images viewed on the main screen by the CamRanger user will
be shared to the CamRanger Share user.

* Auto Share Thumbnails: All images captured will display as thumbnails on the
CamRanger Share devices when Auto Share Thumbnails is enabled. The CamRanger
Share user can scroll through the pictures at his or her own pace.

¢ Share Live View: The CamRanger share user will be able to see the camera’s live view on
their personal device when Share Live View is enabled. If an image thumbnail is not
viewed by the CamRanger user in the main image view, it will not be shared to the
CamRanger Share app users.

* Show Clients: The CamRanger user can see what devices are using the CamRanger Share
application during the CamRanger session.

Note that the watermark settings on the main CamRanger app will be set on all sharing devices.

Assuming that all devices have a good connection with the CamRanger, as the number of users
increase, the performance decreases slightly; adding 1 second per shared device for each small
JPG that is distributed is a good rule of thumb. Similarly, sharing live view with an additional 1
or 2 devices will not significantly degrade performance, but as more devices are added the
frame rate will reduce. Additionally, a device with a very poor/slow connection can degrade
the performance for everyone. The photographer using the CamRanger app can always
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temporarily turn off sharing to kick off all shared devices. As the number of users increases the
there are practical performance limits. Depending on the scenario, practical maximums of 5-15

clients are typical. The amount of data being shared as well as the network strength to all of the
clients dictates the practical maximum.

If the CamRanger is only connected to the CamRanger network, the CamRanger Share app users
will also need to connect to the CamRanger network, using the same password, however no
registration is required. If the CamRanger is bridged to an existing Internet network, the Share
app user can connect to the same Internet network that the CamRanger is connected to, and
still use the Share app. Those using the share app should consult the CamRanger Controller
about the network connection and should stay within range of the CamRanger or bridged
network when using the app

For more information about the CamRanger Share Application, refer to the CamRanger Share
App User Guide Video (Note: this video is demonstrating the setup with an iPad, but the
general concept and use with the Mac is the same).

CamRanger PT Hub and Tripod

* To use the CamRanger PT Hub and Motorized tripod, a
CamRanger is required.

* The CamRanger PT Hub and MP-360 (MP 101, Bescor, or Hague)
will only work with CamRanger firmware 6 and up and the latest
Mac software. Refer to www.CamRanger.com/downloads for
the CamRanger firmware update and latest Mac application.
The CamRanger must be registered (see CamRanger user
manual) while the CamRanger PT Hub does not require
registration.

CamRanger PT Hub Hardware
* The CamRanger powers the CamRanger PT Hub.

Serial Connector port
(Cable included with
CamRanger PT Hub)

USB 2.0 A-end port
(USB2.0AtoB
connector included with
CamRanger Hub)

USB port (USB cable
included with the
CamRanger or Camera)

© CamRanger - Patent Pending 21




MP-360 Tripod Head Hardware

Batteries

Battery Compartment
Cover for 4 AA

Camera Mounting Screw

Vertical Tilt
Head

Auto Pan Angle Selector Switch

Power On LED
Main Power Switch

Pan Angle Indicator Socket for Serial Cable (included with CamRanger PT
Hub) or Hand Held Control Unit

* |nstall Batteries: Open the battery compartment by sliding the cover downward and lifting
it outward, insert the 4 AA batteries in the same position as the markings inside the battery
compartment.

* Mounting the Motorized Pan Head: The motorized Pan Head may be fastened to any tripod
or to any mounting device having a standard UNC %-20 thread mounting screw.

* Mounting the Camera: Fasten the camera securely to the top of the motorized tripod
using the mounting screw, which is a standard UNC 74-20 thread. Align the optical axis of
the Camera with the long dimension of the Motorized Pan Head body.

* Specifications:

@)
@)
@)

@)
@)
@)

Bubble level:

Power source: 4 AA batteries or A/C adapter plug (neither included)

Vertical Tilt Angle: +/- 15 degrees

Horizontal Panning Angle: 360 degrees with unlimited rotation

(If purchased through CamRanger)

Maximum Camera weight: 6 Ib (2.7 kg)

Size (Lx H x W): 5.75 x 4.5 x 4 inches (145 x 115 x 103 mm)

Weight (without batteries: 1.75 |b (800 mg)

If desired, place the included adhesive bubble level on the top of the tripod (on

end with on/off switch).

CamRanger, CamRanger PT Hub, and Tripod Setup

* Required parts:

o

O O O O O

CamRanger*

CamRanger PT Hub

Motorized tripod (either the MP-360, Bescor, or Hague)*
USB cable (included with CamRanger or camera)

Serial Connector (included with the CamRanger PT Hub)

USB 2.0 A to B connector (included with CamRanger PT Hub)
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o Camera*

o Device* (iPhone, iPad, Android device, Mac, or Windows computer)
*Requires charged battery or connection to AC power

* |Important tripod setup instructions:

o Set the Auto Pan Angle Selector Switch to 0° and the Main Power Switch to “M.”
These settings are required for 360° rotation and control from within the
CamRanger app. The 45°, 90°, and 340° auto pan settings on the tripod head
serve no function.

o Level the tripod if necessary for your application.

o When securing the CamRanger and CamRanger PT Hub to the camera setup, do
not mount to the tripod. Mount the CamRanger and CamRanger PT Hub to the
motorized tripod or camera strap and make sure the units can rotate freely
around the tripod.

Motorized Tripod Head

CamRanger

i
' 5 Camera
USB Cable
(Included with CamRanger

(B end) or Camera) \

USB 2.0 Cable (Included
with CamRanger Hub)

Serial Connector Cable
(Included with CamRanger

PTHub)

Diagram of setup for the CamRanger, CamRanger PT Hub, motorized tripod, and camera.

(A end)
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Tips & Troubleshooting

Below are some tips and troubleshooting for common questions or issues arranged by
category:

Registration

If the CamRanger Mac application is re-installed, the Mac may need to be re-registered.
Most registration issues are due to not having Internet connectivity or entering the
serial number incorrectly.

If you still have issues, please email support@CamRanger.com for assistance.

Connection

Make sure CamRanger is fully powered on and initialized (it should take approximately
30 seconds). The power light and WiFi light should both be on.

The password to connect to the CamRanger WiFi is the CamRanger serial number in all
CAPS. If there are still issues connecting, turning the Mac’s WiFi off and then back on
may help.

If the CamRanger application is connected to the CamRanger device, but no camera is
connected, it will attempt to connect to a camera approximately every 5 seconds.

If the Mac is outside of or near the edge of the range of the CamRanger unit there will
be connection problems.

Disconnect and reconnect the CamRanger by selecting “Connection” then Connect on
the Menu Bar to force a new session/connection.

Power cycling the camera and CamRanger as well as restarting the application will
completely refresh the connection.

When the camera battery begins to get low, certain commands may start to fail or a
connection may be refused.

The CamRanger hardware can only be connected to a single Mac at a time.

A second network connection, such as with an Ethernet cable, will likely cause
connection failures.

If there is an inconsistent or intermittent connection, the issue is likely related to the
USB connection and different USB cable will often fix the problem.

Speed

The CamRanger has all the same distance and interference limitations as normal WiFi.
Long distances and solid objects will slow the connection speed.

The CamRanger application can handle very large image files. However, waiting for
those files to transfer from the camera and then over WiFi can be time consuming. A
common operating mode is to shoot RAW along with a small or medium sized JPG.
Newer and faster Mac computers do perform better overall, particularly for intensive
tasks such as showing the 100% resolution images.
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Commands

Depending on the camera and the mode, capture can fail if the camera fails to acquire
focus.
Intervalometer and Bulb commands are stored on the CamRanger hardware such that
the Mac does not need to remain on and connected.
When an operation, command, or setting is not available or not working the issue is
often related to the camera setup. For example:

o Toggling to AF is disabled if the camera lens switch is set to MF.

o Live view will fail on Canon cameras if Live View Shooting is disabled in the

camera’s menu.

o Capture fails because the removable media on the camera is full.
For Canon cameras, the Live View focus mode within the camera’s menu must be set to
“Live View”.
Adjusting or viewing the number of bracketing shots is not currently supported. The
display assumes three shots. However, if the number of shots is actually 2, 5, 7, 9, etc.
the bracket amount is still correct it will just incorrectly display 3 shots.
Some features are not supported by some cameras. For example continuous capture
mode is not supported on the Canon 40D and many Nikons do not support bulb shots.
See the camera capability matrix at www.CamRanger.com/supported-cameras/ for
more detailed information.

Images

The thumbnails are not downloaded until after the image has been recorded to the
camera’s card. On most cameras this is relatively quick. However, depending on the
camera, speed of removable media and number of shots taken in succession, there can
be a lag.

CamRanger can be used to view and download pictures captured through other means.
So a photographer could be capturing images, or a RF or light trigger could capture
images and the CamRanger application would automatically download the thumbnails.
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